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Chapter 1:  Installation 

1.1 Overview 

Full Monte 2016 for Microsoft Project is an add-in that integrates directly into Microsoft Project. The 

advantages of installing directly into Microsoft Project include: 

 Avoiding the necessity of exporting project data to an external application with all the attendant 

issues surrounding export/import. 

 Being immediately accessible as part of the normal Microsoft Project experience 

 Faster access to all required data 

 Avoiding data versioning and ownership issues 

1.2 Prerequisites 

Full Monte 2016 for Microsoft Project is supported with the following environments: 

Microsoft Project (Standard or Professional x86 or x64 editions) 

Microsoft Project 2007 

Microsoft Project 2010 

Microsoft Project 2013 

Microsoft Project 2016 

Operating Systems 

Microsoft Windows XP SP3 (x86) 

Microsoft Windows 7 SP1 (x86 or x64) 

Microsoft Windows 8.1 (x64) 

Microsoft Windows 10 (x64) 

Additional Requirements  

Microsoft .Net Framework 4.0 Client (Windows 7 or earlier) 
Microsoft Visual Studio Tools for Office (VSTO) 2010 Runtime 
Microsoft Office 2007 PIA (Microsoft Project 2007 only) 

1.3 User Account Requirements 

Full Monte for Microsoft Project must be installed using an account with Administrator rights to the 

local computer for two reasons: 

 

1. By default the application will be installed to C:\Program Files (x86)\Barbecana\Full Monte MSP 

so that it may be used by any account on the computer. 

2. It may be necessary to install addition pre-requisite system components (for example 

Microsoft .Net 4.0) that can only be installed by Administrators. 

 

NOTE: It is not sufficient to use Run as Administrator to execute the installation program. 

Once installed, the application may be used by any user account that is able to run Microsoft Project. 



1.4 Obtain the software 

Download the software from the Barbecana website by using the link provided when you purchased the 

software or by requesting a 30 day trial (which will send an automated email with a link to download the 

software). 

NOTE: The ‘trial’ software downloaded from the Barbecana website is a fully functional version 

of the software that will switch to an ‘academic’ mode (restricted to 100 tasks with no external 

project links) after 30 days from initial use unless a purchased license key is entered. 

1.5 Install the software 

While not essential, we recommend closing Microsoft Project and other applications prior to installing 

Full Monte.  Doing so may avoid the need to restart Windows following the install. 

Using an account with Administrator rights, install Full Monte by running the setup program 

FullMonteMSP.exe on the client machine where Microsoft Project is installed. 

If prompted, please restart Windows. 

NOTE: If the Full Monte menu items do not appear as described below when Microsoft Project is 

first opened after installing Full Monte, please reboot the computer and re-try Microsoft Project 

before proceeding to the trouble shooting steps outlined in appendix A. 

1.6 Verify Correct Installation 

After installing Full Monte, launch Microsoft Project. 

If messages similar to the following are displayed, please allow Microsoft Project to complete any 

additional configuration before attempting to access Full Monte. 

 

The appearance of the menu items, as shown in the following screenshots, is confirmation that Full 

Monte had been correctly installed and is functional. 

Microsoft Project 2007 

In Microsoft Project 2007, Full Monte will appear as two additional items on the menu bar. 

 



 

Microsoft Project 2010, 2013, 2016 

In versions of Microsoft Project later than 2007, Full Monte will appear as items on the Add-Ins 

menu tab. 

 

If the Full Monte menu items do not appear within a few seconds of launching Microsoft Project, or are 

displayed but are unresponsive, please review the trouble shooting steps described in Appendix A of this 

manual. 

About Full Monte 

Selecting Full Monte Administration, About Full Monte will display information similar to the following: 

 

NOTE: In this example the product is shown as ‘unlicensed’.  This will be the case until you begin your 

trial period (by first using the product) or register a purchased license. 



Chapter 2:  Registration 

2.1 Trial / Academic Mode 

When Full Monte is first used after installation, it will initialize a 30-day trial license. 

NOTE: If the same major version of Full Monte has previously been installed on the same computer, 

Full Monte will use any previously installed license.  If the previous license is an expired trial license 

(first used more than 30 days prior), Full Monte will immediately switch to ‘academic’ mode. 

The 30-day trial license enables the full functionality of the product, with no restrictions, for 30 days.  

After the 30-day trial period expires, the software will change to a limited ‘academic’ mode that allows 

continued use of the software with two restrictions. 

1. Full Monte can only be used with projects of 100 tasks or less 

2. Full Monte cannot be used with projects that contain external links 

At any time, the software can be fully activated by entering a license key that can be purchased from 

Barbecana Inc. 

The current status of the software can be viewed by selecting Full Monte Administration, About Full 

Monte. 

 

The About Full Monte dialogs includes version information (that may be requested for support 

purposes) and details of the License Key and Serial Number (if a purchased license has been installed). If 

the software is in ‘trial mode’, the license will state it is ‘temporary single-machine license’, the serial 

number will be all zeros, and the Licensee will be ‘trial’. 

One the 30-day trial period has elapsed, the About Full Monte dialog will show the license as ‘an expired 

single machine license’. 



 

The software will now be in ‘academic’ mode with the limitations set as follows: 

1. Full Monte can only be used with projects of 100 tasks or less 

2. Full Monte cannot be used with projects that contain external links 

If you attempt to use Full Monte on a project that does not meet these ‘academic’ mode criteria, the 

following message is displayed: 

 

2.2 Purchasing a License 

Individual perpetual licenses for Full Monte can be purchased through our web site at 

www.barbecana.com. 

For larger quantities and for details of any applicable corporate/volume discounts, please contact 

Barbecana sales at sales@barbecana.com or call the number on our web site. 

For each license purchased, you will be allocated a unique 5 digit numeric serial number.  This serial 

number is used to track each licensed copy of the software for maintenance and support purposes. 

NOTE: Customers who purchased Full Monte before the introduction of the unique 5 digit serial 

number (typically those with current license keys in the IPRL-XXXXXX-XXXXXXXX-XXXXXXXX-

http://www.barbecana.com/
mailto:sales@barbecana.com


XXXXXXXX-XX-XXXX format), will need to contact Barbecana (sales@barbecana.com) providing their 

old license key/purchase order number to determine their allocated serial number.  

2.3 Registering the Software 

While the 5 digit numeric serial number uniquely identifies your right to use a licensed copy of the 

software, the actual license is installed into the software using a two part license key comprising: 

1. A License Key in the form of DF01-XXXX-XXXX-XXXX-XXXX-XXXX-XXXX (where X can be any 

alphanumeric character) 

NOTE: If you already have a license key from an older version of Full Monte in the format of IPRL-

XXXXXX-XXXXXXXX-XXXXXXXX-XXXXXXXX-XX-XXXX or AF01-XXXX-XXXX-XXXX-XXXX (where X 

can be any alphanumeric character) you will need to obtain a new key for the new version.  

Customers with a current maintenance agreement can obtain the new license key free of charge. 

2. A Licensee name in the form of a string of characters, for example “Barbecana Inc”.   

The License Key contains coded information including the Serial Number, Licensee, and Trial Expiration 

Date (if applicable).  The License Key and Licensee name must be used together exactly as provided. 

The License Key/Licensee name may be provided to you either by Barbecana or your company Full 

Monte license administrator. 

NOTE: To obtain a License Key from Barbecana, you will require the unique 5 digit serial number 

provided to you when you purchased the software. 

To obtain a License Key from Barbecana, please choose the Full Monte Administration, Register Full 

Monte option from the Microsoft Project Add-Ins menu. 

 

Click the ‘Get a License Key’ button. 

mailto:sales@barbecana.com


 

Entries with an asterisk (*) are mandatory. 

Name – Please enter the name of the end user to whom the license will be allocated 

Company – This is an optional entry and will typically be the Company/Organization name that 

purchased the license.   

Note: If the Company name is provided then this will be used as the Licensee name for the 

license. If no company is specified then the Name entered will be used for the Licensee name. 

Email Address – This is the email address where the license information will be sent. 

Serial Number – This is the unique 5 digit numeric serial number issued when the license was 

purchased. 

After the information is entered, click Email to generate an email to Barbecana. 

The following confirmation will be displayed: 

 



The email will contain information similar to the following (and can be viewed before sending). 

To: sales@barbecana.com 

::My Name::My Company::myname@company.com::Serial Number::NNNNN::FM_2016_MSP 

[Version 3.0.15212.2]::3C970E08740F::  

The encoded information in the email is as follows: 

 Name 

 Company 

 Email 

 Serial Number (5 numeric digits) 

 Barbecana Product being registered (Product Version) 

 MAC address of the registered computer (may be removed) 

If you prefer, you may enter the Name, Company, Email Address, and Serial number into a manually 

generated email, or call our office to provide the information over the phone. 

After Barbecana has validated the supplied information, the License Key and Licensee information will 

be returned by email (or can be provided by phone): 

The body of the email from Barbecana will contain information similar to the following. 

 

On the Full Monte Administration menu choose Register Full Monte. The Register License dialog will be 

displayed. 

Your Full Monte 2016 (MSP) license key is [DF01-XXXX-XXXX-XXXX-XXXX-XXXX-XXXX]  

Your serial number is NNNNN. Please refer to this number in requests for support or 
new license keys.  

The registered Licensee is [My Company]  

Please enter the license key and registered licensee name (excluding the square brackets) into 
the fields provided in the registration dialog, taking care to differentiate between 0/O and 1/I 
when entering the license key.  The Licensee name must be entered exactly as shown. 

Please do not hesitate to email Barbecana Full Monte Support 
(fullmontesupport@barbecana.com) for questions regarding the software. 



 

Enter the license key exactly as provided by Barbecana. Once a valid license key has been entered you 

may then enter the Licensee name, again exactly as provided by Barbecana. 

 

If the Licensee information does not match the encoded information in the License Key the following 

dialog will be displayed: 

 

After clicking OK to dismiss the Invalid Licensee dialog, you must again choose Register Full Monte from 

the Full Monte Administration menu. 

If the correct License Key and Licensee information is entered then the Registration process is 

completed by clicking OK on the dialog. 

The installed license can be verified by selecting the Full Monte Administration, About Full Monte menu 

option. 



 



Chapter 3:  Field Mapping, Data Import/Export, and Data Conversion 

3.1 Introduction 

Full Monte uses Microsoft Project’s custom fields to store its data.  Since other applications may also use 

these fields, it is important to specify which ones should be used by Full Monte in order not to create 

conflicts.  

The term “Field mappings” refers to the process of choosing which custom fields are used. 

NOTE: As different projects may use different fields for other purposes, Full Monte allows each 

project to have its own mappings.  There is also a default mapping used by projects new to Full 

Monte.  (When a new project is opened for the first time Full Monte checks for any potential 

conflicts.)   

By default, Full Monte 2016 uses far fewer custom fields than previous versions of Full Monte, making it 

easier to avoid conflicts (See Appendix B for a comparison of custom field utilization). On the other hand 

it allows you to add additional mappings for data that was not available to map in previous versions, so 

that you can: 

 Share more results with other Microsoft Project users who do not have Full Monte 

 More easily migrate data between third party applications and Full Monte 

 Set up bi-directional sharing of input data between Microsoft Project and Full Monte 

Most of these user fields are on the task table, but unlike previous versions, Full Monte 2016 also 

supports two user fields on the resource table as well (for Resource Rate uncertainty information), 

though by default they are not mapped. 

3.2 System vs User vs Project Mappings 

Full Monte remembers up to three different sets of field mappings.  In the simplest case, all three sets of 
mappings will be identical but in practice each user may specify their own default custom mappings for 
new projects. It is also possible that each project may have its own unique mappings if the available 
custom fields are not consistent across projects. 

System Mappings 

These are built into the product and are the initial set of default mappings applied when Full Monte is 
first used. 

The default System field mappings are shown in figure 3.1 



 
Figure 3.1 

User Mappings 

These are an optional set of field mappings (stored for each Full Monte user) that, if defined, are used 
for new projects in place of the default System mappings.  This allows the user to remove any standard 
mappings that are not required (with the exception of the two mandatory fields Full Monte Input Data 
and Full Monte Results) and also add their own user specific mappings. 

Project Mappings 

The field mappings in use for each project are stored with the project and may be different from both 
the default System mappings and the current User mappings. While not an ideal scenario, primarily 
because it can be confusing, this may be necessary if projects are from different sources that have 
reserved different custom fields for other purposes. 

NOTE: The standard Full Monte fields shown above contain data which is encoded to save space 
and are intelligible only by Full Monte. Additional ‘human readable’ data can also be mapped 
and this is explained in section 3.5.  

3.3 Using Full Monte on a project for the first time 

When Full Monte is first used with a project that has not been used with Full Monte before, it will 
employ either the User default mappings if defined, or the System default mappings if no User mapping 
has been specified. 



Full Monte will verify if the mapping can be used on the opened project by scanning each mapped 
custom field for existing data. 

NOTE: On a large project this may take some time. Please be patient. 

If Full Monte finds no conflicts (no pre-existing data in the mapped custom fields), then the mappings 
will be saved into the project and the user can begin to use Full Monte. 

However, if existing data is found in the required mapped fields, Full Monte will display a warning 
message describing the conflicts encountered as shown in figure 3.2. 

 
Figure 3.2 

If you choose Yes, Full Monte will scan other custom fields looking for columns that currently contain no 
data. Again, this may take some time. As available custom fields are found they will be mapped to Full 
Monte fields.  At the completion of the process the Field Mapping Information dialog will be displayed 
to allow the user to verify that required information has been successfully mapped. An example is 
shown in figure 3.3. 



 
Figure 3.3 

In this example, the ‘Early Start Histogram’ mapping has been changed from the default of custom field 
Text7 to Text15. 

If the user clicks OK, this project specific mapping will be saved for future use with this project. 

If the proposed mapping is not acceptable, perhaps because it failed to successfully map sufficient fields 
or the proposed fields are known to be required for other purposes, then the user has three choices: 

 Manually modify the proposed mapping until it meets their requirements 

 Reset the mapping to the User’s default values 

 Reset the mapping to the System default mapping. 

If these choices result in mappings that use custom fields with pre-existing data then the user will be 
offered one final warning that data may be lost as shown in figure 3.4. 



 
Figure 3.4. 

If the user chooses to proceed, the custom mappings will be saved for the project. 

3.4 Managing Field Mappings 

To change mappings for the current project, select Edit and then Manage Field Mappings.  You will see 

the dialog shown in figure 3.5. 

 
Figure 3.5 

NOTE: It is not possible to modify field mappings once project data has been changed in a Full 
Monte session.  If the Manage Field Mappings option is disabled then you will need to close Full 
Monte (saving or discarding your data changes as appropriate) and then restart Full Monte. 

The dialog has two tabs, and always comes up with the task tab selected.  The first column is a 

description of the Full Monte Data. In the second column, you see the names of the user fields to which 

they are mapped. To change a mapping, click on the field in column 2 that you wish to change and select 

a new mapping from the drop-down list that appears (see figure 3.6).  



 
Figure 3.6 

Select a new mapping by clicking on it. 

NOTE: The list reminds you of any current data mapped to each field, but it does not stop you 

selecting one that is.  If you do so the user field will temporarily be mapped to two different 

items of Full Monte data.  This conflict must be resolved before you press OK. 

If you are not interested in storing certain information (for example, the ‘histogram of free slack’ may be 

of no interest) you can delete it altogether by selecting the row (click on the left hand cell, and hit the 

Delete key. 

NOTE: The only mandatory fields are “Full Monte Input Data” and “Full Monte Results”. 

Removing unnecessary mapped fields reduces the time taken to open and save project data but 

may reduce functionality. For example if the mapping for Early Finish Histogram is removed, then 

the histogram will not be available for reports in a new Full Monte session until a risk analysis 

has been performed. 

When you click OK, Full Monte will check that there is no data in any user field which is now mapped but 

which was not mapped when the dialog was opened.  If there is you will be given the chance either to 

overwrite that data or to change the mapping. 

Select the ‘Make this the user default’ check box to save the revised mappings as the current users 

default settings to be used when future projects are opened for the first time in Full Monte. 

NOTE: Any changes to the users default mappings will not be applied to other projects with 

existing Full Monte data unless the user opens the Field Mapping dialog and clicks ‘Reset this tab 

to User Default Values’ as each existing project is opened.. 



The Resource tab works in a similar way but is simpler.  You cannot add or removed rows.   Instead of 

deleting the row, unmapped rows show “NONE” in the “MSP Field” column. 

3.5 Mapping Additional Data 

Beyond the standard fields shown in figure 3.1, the user can map additional fields for two purposes. 

 Saving additional ‘human-readable’ data for use in standard Microsoft Project views 

 Defining read/write fields that allow Full Monte data to be updated in Microsoft Project 

To do this, scroll to the bottom of the mapped field list and click on the empty cell at the bottom of the 

“Data” column.  You will get a cascading menu similar to that used to add columns to a view.  When you 

select a data item, Full Monte will map it to the first available MSP user field of the appropriate type.  

You can of course change it as described above. 

NOTE: By “available” is meant that it does not conflict with any existing Full Monte mapping.  It 

may still conflict with other uses of the field, but this is checked later when you click OK.  

See figure 3.7 for an example of mapping additional Full Monte data into Microsoft project custom fields 

for reporting purposes in Microsoft Project 

  
Figure 3.7 

The Early Start/Finish Expected (Mean) values have been mapped to custom fields Start1/Finish1 and 

the Early Start/Finish P80 percentile dates have been mapped to Start2/Finish2.  The activity Percent 

Critical data is being saved to custom field Number1. 

When the user clicks OK, and assuming no conflict is detected, the custom field names in Microsoft 

project will be updated as shown in figure 3.8 



  
Figure 3.8 

The data can then be included in standard Microsoft Project views as shown in figure 3.9 



  
Figure 3.9 

 

Defining Read/Write Fields 

Certain data fields may be mapped so that information can be updated in both Microsoft Project and 

Full Monte.  These fields are: 

 Duration Distribution Type 

 Duration Optimistic 

 Duration Most Likely 

 Duration Pessimistic  

This allows users without access to Full Monte to update basic duration uncertainty information outside 

of Full Monte.  When Full Monte loads data from a project with these fields mapped, it will attempt to 

read any existing data in these fields. If the data is missing or invalid, then any existing Full Monte data 

read from the Full Monte Input Data will take precedence.  When the user finishes their Full Monte 

session and chooses to save Full Monte input data, the session data will be saved to both Full Monte 

Input Data and the mapped custom fields. 

NOTE: Since the data saved to Microsoft Project custom fields may not be viewed in the same 

hierarchy as seen in Full Monte, all inherited values are converted to explicit values when saved 

and will subsequently loaded into Full Monte as explicit (not inherited) values. 

3.6 Data Import 

Earlier versions of Full Monte featured the ability to migrate Deltek Risk+ uncertainty data into Full 
Monte.  This feature has been replaced by an Import option on the File menu which allows basic task 
uncertainty data to be loaded from Microsoft Project custom fields. 



Note: The Import facility is designed for infrequent/one-off loading of data from external 
systems. For recurring data transfer we suggest permanently mapping input fields as shown in 
section 3.5 

 

  
Figure 3.10 

Figure 3.10 shows an example of the Import Dialog configured to load basic Risk+ uncertainty data. 

The Duration Distribution Type field can be imported from either Numeric or Text custom fields.  Only 
valid data will be loaded as defined in the following table: 

Distribution Type Numeric Field Text Field 

None 0 (None) or <blank> 

Beta 4 Beta 

LogNormal 5 LogNormal 

Normal 3 Normal 

Triangular 2 Triangular 

Uniform 1 Uniform 

 



3.7 Data Export 

Full Monte data and results can be saved to Microsoft Project custom fields on a one-off basis using the 
File; Export… menu option. 

Note: Full Monte does not check for any existing data in the custom fields specified for the 
export. Any existing data in those fields will be overwritten without warning by the export. 

 

  
Figure 3.11 

While most Full Monte fields can only be exported to Microsoft Project custom fields of the same data 
type, some fields can be exported to multiple data types. 

Duration Distribution Type – This can be exported to either a Numeric or Text custom field.  

Export values will be: 

Distribution Type Numeric Field Text Field 

None 0 (None) 

Beta 4 Beta 

LogNormal 5 LogNormal 



Normal 3 Normal 

Triangular 2 Triangular 

Uniform 1 Uniform 

Duration Optimistic/Most Likely/Pessimistic – These fields can be exported to either Duration or 
Numeric custom fields.  When exported to custom fields of type Duration, the values will be exported as 
durations.  When exported to numeric custom fields, the values will be exported as Percentages.  

3.8 Conversion from Full Monte 2.1 

When a project that contains data from Full Monte 2.1 is first opened the dialog show in figure 3.12 is 
displayed 

  
Figure 3.12 

Clicking OK will convert the existing input data into the correct format for Full Monte 2016 and apply the 
current mappings. The process will then continue as per section 3.3. 

Note: Where you have linked projects, each project must be opened and converted individually. 

Note: Unlike Full Monte 2.1 (that required all linked projects to have the same mappings), Full 
Monte 2016 allows linked projects to have different Full Monte field mappings.  This greatly 
simplified the process of performing a Schedule Risk Analysis on linked projects from multiple 
sources. 

 

 

 

 



Appendix A:  Installation Trouble-Shooting 

In the event that Full Monte does not appear on the Microsoft Project menu after installation please 

review the following trouble shooting suggestions. 

A.1 Microsoft Project 2007 

Add the COM Add-Ins menu item to the Microsoft Project 2007 menu as follows. 

From the Microsoft Project 2007 Tools menu, choose Customize; Toolbars. 

On the Commands tab, select Tools and locate the COM Add-Ins command as shown in figure A.1. 

 
Figure A.1 

Click and Drag the COM Add-Ins command from the dialog up onto the Microsoft Project Tools menu.  

The menu will expand automatically. Drop the COM Add-Ins command on the Tools menu. Figure A.2. 

 
Figure A.2 



NOTE: To subsequently remove the COM Add-Ins command from the tools menu, display the Tools; 

Customize dialog, open the Tools menu and drag the COM Add-Ins command from the menu onto the 

Customize dialog. 

 

Click on the COM Add-Ins item on the Tools menu. A dialog similar to the following will be displayed. 

 
Figure A.3 

In this example Full Monte is listed and shown as enabled.  If Full Monte is not listed then please retry 

the installation (verifying you are using an account with Administrator rights). 

If Full Monte is listed but not enabled, please select the box to enable Full Monte. Click OK to close the 

COM Add-Ins dialog.  If the Full Monte menu items do not appear or are unresponsive when clicked, 

please again open the COM Add-ins dialog. Select the Full Monte row as shown in figure A.4. 

 
Figure A.4 

After selecting the Full Monte row, observe any message against ‘Load Behavior’ at the bottom of the 

dialog.  If the message ‘Not loaded. A runtime error occurred during the loading of the COM Add-In.’ is 

displayed, then the most likely cause is a missing pre-requisite.  Please review the Missing Pre-requisite 

section A.3. 

After installing any missing pre-requisites you will again need to re-enable Full Monte in the COM Add-

Ins dialog. 



A.2 Microsoft Project 2010, 2013, 2016 

Open the Project Options dialog. 

From the File menu, choose Options and select the Add-Ins tab as shown in figure A.5. 

 
Figure A.5 

Choose Manage ‘COM Add-Ins’ and click Go…  A dialog similar to the example in figure A.6 should be 

displayed. 

 
Figure A.6 



In this example Full Monte is listed and shown as enabled.  If Full Monte is not listed then please retry 

the installation (verifying you are using an account with Administrator rights). 

If Full Monte is listed but not enabled, please select the box to enable Full Monte. Click OK to close the 

COM Add-Ins dialog.  If the Full Monte menu items do not appear or are unresponsive when clicked, 

please again open the COMM Add-ins dialog. Select the Full Monte row as shown in figure A.7. 

 
Figure A.7 

After selecting the Full Monte row, observe any message against ‘Load Behavior’ at the bottom of the 

dialog.  If the message ‘Not loaded. A runtime error occurred during the loading of the COM Add-In.’ is 

displayed, then the most likely cause is a missing pre-requisite.  Please review the Missing Pre-requisite 

section A.3. 

After installing any missing pre-requisites you will again need to re-enable Full Monte in the COM Add-

Ins dialog. 

A.3 Missing Pre-Requisites 

The exact pre-requisites required by Full Monte depends on multiple factors that include: 

 Version of Windows 

 Version of Microsoft Project 

 Other programs previously installed/removed. 

NOTE: When programs are uninstalled from Windows, they often leave behind components that 

might be shared with other applications.  These ‘orphaned’ shared components will remain available 

to other applications but may not appear in the list of installed programs. 

While the Full Monte installation program will attempt to install any missing pre-requisites, it may fail 

for several reasons including: 

 No access to the internet 

 Conflicts with other installations 

 Mistakenly believing a pre-requisite is already installed 

The following list describes the components required. The files can be downloaded from the Microsoft 

download center if they are not successfully installed by the Full Monte installer. 



Microsoft .Net Framework 4.0 Client Profile (4.0.30319) 
Microsoft Visual Studio Tools for Office (VSTO) 2010 Runtime (10.0.50903) 
Microsoft Visual C++ 2010 Redistributable (10.0.40219) 
Microsoft Office 2007 PIA (12.0.4518.1014) - Microsoft Project 2007 only 

NOTE: The version numbers in parenthesis are for guidance only and may be superseded by later 

versions from Microsoft. 

 



Appendix B:  Full Monte 2.1 vs Full Monte 2016 Custom Field Utilization 

The following table presents a comparison of the default custom field mappings used by Full Monte 2.1 

and Full Monte 2016.   

Full Monte Data 
Project Custom Field 

FM 2.1 FM 2016 

Cost Expected Value Cost1   

Cost Standard Deviation Cost2   

Cost Sensitivity Optimistic Cost3   

Cost Sensitivity Pessimistic Cost4   

Merge Point Delay Duration1   

Total Slack Standard Deviation Duration10   

Early Start Standard Deviation Duration3   

Early Finish Standard Deviation Duration4   

Late Start Standard Deviation Duration5   

Late Finish Standard Deviation Duration6   

Free Slack Expected Value Duration7   

Free Slack Standard Deviation Duration8   

Total Slack Expected Value Duration9   

Early Finish Expected Value Finish1   

Late Finish Expected Value Finish2   

Optimistic Project Finish (sensitivity) Finish3   

Pessimistic Project Finish (sensitivity) Finish4   

Cost Sensitivity Attributable Variance Number10   

Percent Active (branching) Number6   

Percent Critical Number7   

Sensitivity Index Number8   

Sensitivity Attributable Variance Number9   

Early Start Expected Value Start1   

Late Start Expected Value Start2   

Full Monte Input Data (Mandatory) Text1 Text1 

Early Start Histogram Text11   

Early Finish Histogram Text12 Text7 

Late Start Histogram Text13 Text11 

Late Finish Histogram Text14 Text10 

Free Slack Histogram Text15 Text9 

Total Slack Histogram Text16 Text13 

Cost Histogram Text17 Text4 

Analysis Log Messages Text18 Text3 

Full Monte Results (Mandatory)  Text2 



Duration Histogram   Text5 

Finish Histogram   Text8 

Start Histogram   Text12 

 

With Full Monte 2016 for Microsoft Project, all data that was previously stored in Cost, Duration, 

Number, Start and Finish custom fields has now been consolidated into a single Text field (Full Monte 

Results).  This dramatically reduces the total number of custom fields required for Full Monte data. 

Furthermore, the user can choose to modify the default mappings to just two mandatory fields (Full 

Monte Input Data and Full Monte Results). 

Note: If histogram data is not mapped to custom fields then histogram and percentile data will 

not persist between sessions and a Risk Analysis must be performed to re-create the data before 

histogram and percentile data will be available for viewing/reporting in a new session.  

Barbecana recommends that histogram data for important fields like ‘Early Finish’ is mapped to 

a custom field so that it persists between sessions. 

As well as the mandatory and suggested mapped fields, the user can also add mappings for any other 

Full Monte data they wish to be available in a Microsoft Project custom field.  This includes uncertainty 

and percentile data. The example in figure B.1 includes the mapping of the Optimistic Duration 

(Duration Optimistic) and the P80 Early Finish (Early Finish Percentile (80%)). 

 
Figure B.1 

External subprojects 

Full Monte 2016 no longer requires that linked projects share the same field mappings. This greatly 

simplifies performing a schedule risk analysis on an IMS comprising schedules from different sources. 



Appendix C:  Conversion from Full Monte 2.1 

When a Microsoft Project file previously used with Full Monte 2.1 is opened in Full Monte 2016, the 

dialog shown in figure C.1 is displayed. 

 
Figure C.1 

The data conversion process is one-way which means after conversion Full Monte 2.1 will no longer 

recognize any Full Monte data in the project.  If you anticipate a need to use an earlier version of Full 

Monte then you must either not save the project or save the project to a new name after conversion. 

To abort the conversion simply click Cancel. 

If you select OK, the existing Full Monte 2.1 data will be converted into the new format used by Full 

Monte 2016.  This will release any Microsoft Project custom fields that are no longer required by the 

new Full Monte 2016 mappings.  Full Monte will then display the Task Edit view. 

When you first close Full Monte 2016 after converting an existing project, one final warning will be 

issued (figure C.2) to remind you to save the file to a new name if you wish to retain a version containing 

the original Full Monte 2.1 data. 

  
Figure C.2 

 



Appendix D:  Full Monte 2016 and Project Server 

Full Monte can be used as normal with Microsoft Project projects that are opened from Microsoft 

Project Server.  Since all Full Monte data is stored in regular Microsoft Project custom fields, any data 

entered into Full Monte will be saved back to the Project Server using those custom fields (Text1-30, 

Start1-10 etc.) as defined in the Full Monte project field mappings (see chapter 3 for a full discussion 

regarding field mapping). 

In Microsoft Project server it is possible to define Enterprise custom fields in addition to the standard 

custom fields support by Microsoft Project Standard/Professional. 

Full Monte 2016 has been enhanced to add support for Project Server Enterprise Fields when available. 

Note: No special Enterprise Fields are required for Full Monte to work with projects opened from 

Project Server but using Enterprise fields as described below can free up existing regular custom 

fields for other purposes. 

Full Monte supports Enterprise Fields with Microsoft Project Server 2010 and later. 

The major difference between the standard pre-defined custom fields in a standalone copy of Microsoft 

Project and Enterprise fields in project Server is that Enterprise Fields are created/named by the Project 

Server administrator and are in addition to the regular custom fields (Text1-30 etc.). 

Where an Enterprise field has been created with a name recognized by Full Monte, it will be 

automatically used by Full Monte for all projects created using the Project Server definition. 

D.1 Creating Project Server Enterprise Fields 

New Enterprise custom fields are created on the Project Server Settings/Enterprise Custom Fields form. 



 
Figure D.1 

To add an Enterprise Custom Field for use by Full Monte 2016, click New Field. 

 
Figure D.2 



The unique Name must match exactly the spelling of the Full Monte field, in this example ‘Cost 

Histogram’. 

The Entity should be set to ‘Task’ for any fields displayed on the Task Fields tab of the Field Mapping 

dialog or ‘Resource’ for fields displayed on the Resource Fields tab of the dialog. 

Remaining fields should be set as follows: 

Custom Attributes - None 

Department – Leave blank or set to a department code that includes Full Monte users 

Calculation for Summary Rows – None 

Calculation for Assignment Rows – None 

Values to Display – Data 

Behavior: Require that this field has information - No 

D.2 Using Enterprise Fields in Full Monte 

The first time a project is opened in Microsoft Project after Full Monte Enterprise fields have been 

added to the server, you may see the message shown in figure D.3 

  
Figure D.3 

This indicates that the Enterprise fields recently defined in Project Server have the same name as local 

custom fields previously being used by Full Monte.  Since Microsoft Project does not allow Enterprise 

and local custom fields of the same name you must rename the local fields before you are allowed to 

open the project. 

Note: This will result in the data being lost to Full Monte.  If the field contains input data you may 

be able to use the Full Monte import function to re-load the data from the renamed local custom 

field after you start Full Monte. 

When Full Monte starts while Microsoft Project is connected to a Project Server, Full Monte will scan for 

Enterprise fields that match Full Monte field names and automatically adjust the field mappings to 

include those fields as shown in figure D.4 

 
Figure D.4 



D.3 Saving projects with Enterprise fields to files 

If you save a project from the Project Server to a local file, you should choose the option to save ALL 

Enterprise Fields to the local file.  While this will result in a larger file it will ensure that all Full Monte 

fields (even those not currently populated) will be available for use in Full Monte while working with the 

standalone project file. 

 
Figure D.5 


